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What is Microsoft Access?

Microsoft Access is a powerful relational database tool. A database is a collection of
information that's related to a particular subject or purpose, such as tracking student
information or tracking customers and orders. A relational database allows you to assign
relationships among data and tables for analysis and reporting.

Using Microsoft Access, you can manage all your information from a single database file.
Within that file, you can divide your data into tables; view, add, and update table data by using
online forms; search for just the data you need by using filters and queries; and analyze or
print data in a specific layout by using reports. The most efficient databases contain different
tables for each type of information that needs to be tracked. The information from multiple
tables can be brought together by a query, form, or report.

The Big Picture

Access is made up of multiple components. For instance, a company might just have one
database to contain all of its information. However, within that database, there would be
multiple tables. Tables can be displayed in datasheet format or using forms. Reports can be
created from the data entered in the tables.

Tables

The main organizational structure of every database is the tables used within it. Using the
example mentioned above, a company might have tables with employee information,
customer information, invoices, products, and shipping.

Fields

Each table is comprised of fields. For instance, a table about employees might contain the
following fields: First name, Last name, Phone, Address, Social Security Number, Hire
Date, Salary, etc.

Records

Also within each table, there are elements referred to as records. In the table about
employees, all the information about one specific employee would be a record.
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Starting Access

Follow these steps to start Access. Initially, to become familiar with a database and tables,
we will use the Access Practice database file. This is available in the classroom and from the
web page, www.carlsonschool.umn.edu/oitcourses (click the Access course description).

1. Click the Start button on the lower-left portion of the Windows taskbar.

2. Select Programs, Microsoft Access. (This may be in a slightly different location, depending
upon the configuration of your computer.)

Microsoft
Office
Button

or
Double-click the Access shortcut icon on your desktop if one is available. The following
window displays. Ready-to- Access
> Hel
() d = use Microsoft Access - | Y
2 templates o\ &
Template Categories <+—
Featuring . . .
e Getting Started with Microsoft Office Access
cal Templates
o ticraseit Offics Ouline New Blank Database - Open Recent Database
Business
Education Create a B5 More...
Personal [% o SN < new blank ZA)| \}Acess Practice 2007.accdb
Sample i Featured Online Templates database %) \.\Northwind Practice 2007...
Non-profit | 2/26/2008
3 £ Northwind Practice 2007.accdb Recently
| L @ e opened
i~ S databases
| u_] \..\Datasheets I- Create a ...
Assets &/ &9/ 0Us
J E_] Marketing projects.accdb
‘ & Faculty.accdb
‘ “m‘ ind 2007.accdb
‘ D rge test.mdb
| . b8 08
F’.gowfﬁ' Online ;.Iore o.n Office On_lme ‘
raining | Templates | Downloads
What's new in Access 20077
B The new Access 2007 contains Get the latest content while
more powerful tools to helpyou @ working in the 2007 Microsoft
quickly track, report, and share Office system
information in a manageable ® Guide to Access 2007 User Interface
environment, Learn more about ENTIT aii +
the new features and ° urgarzue all ,_oux ome.c(s using the
improvements. new, easy access Navigation Pane
Ready

This window provides options to:
e Create a blank database
e Use one of Microsoft's templates.
e Connect to Microsoft online to download templates or get help.

e View a list of recently opened databases the right side of the screen.

Using Help

From all screens in Access, click the Help button in the upper-right corner for assistance
with any topic.
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What is Different about Access 20077

The primary difference for Access 2007 is the significant change to the user interface. For
people with prior experience in Access, it can be a challenge to find familiar features.
However, for those new to Access, the interface is intuitive and easy to manage. There are
also changes to file format and users who do not have Access 2007 will not be able to open
your database unless you save it to an earlier version.

Microsoft Office Button L
The Microsoft Office Button, located in the upper-left corner of the Access screen allows you
to view many options that were previously available from the File menu, such as Open, Save
As, and Print. It also provides an option to convert databases from earlier versions of Access
(.mdb format) to the new (.aacdb) format. This Convert option is available when you open a
database from an earlier version.

File Compatibility with Earlier Versions of Access

The file format for Access 2007 cannot be opened with earlier versions of Access. If you must
share your database with those using earlier versions, you should save down to a lower
version. If you have an older database that you would like to convert to Access 2007, you can
do so from the Office button, either through the Save As option or by selecting Convert.

{n_% . s 19043 : Database (Ac
i

Recent Documents
j Hew
119043.mdb

=) 4
7 Open 219043.accdb

3 ..\Acess Practice 2007.accdb
— } onaen 4..\Morthwind Practice 2007.accdb Recently
5 Morthwind Practice 2007.accdb opened
& \Documents and Settings'...\19043. mdb databases
7 .\Datasheets I- Create a table by...
I’l:_ Save As » 8 Marketing projects.accdb
9 Faculty.accdb
i
j' Print 3
P
J"ﬂ Manage 3
GE. E-mail

-
| LClose Database

2] Access Options Exit Access

To modify options for Access, click the Access Options button. See information on changing
default file format which follows.

Note: New features of Access 2007 include allowing multi-value fields and attachments.

Copyright © 2008, Carlson School of Management, University of Minnesota 3



Microsoft Access 2007 Overview

Changing the Default File Format

You can change the default file format, if
desired. Click the Access Options button;
then in the Popular options, select the
desired format.

Note: For this class, we will use the
Access 2007 (.accdb) format. Check
Microsoft Help for further information.

The Ribbon

Popular

Current Database
Datasheet
Chject Designers
Praofing
Advanced
Customize
Add-ins

Trust Center

Resources

By
_‘% Change the most popular options in Access.

Top options for working with Access

Always use ClearType

SereenTip style: | Show feature descriptions in ScreenTips b

Show shortout keys in ScreenTips

Lolor scheme: Elug w

Creating databases

Default file format: Access 2007

Default database folder: | Access 2000 ngs\Comp Adminig

Access 2002 - 2003 m

New database sort arder: 4

As with other Office 2007 applications, Access uses the new Ribbon interface. The Ribbon
replaces the menu bar with which most users are familiar. Tasks are grouped together on
different command tabs. Each tab has a group or “gallery” of related tasks.

Quick Access Toolbar

o) = Table Tools | Microsoft Access

i3
Eate External Data Database Tools Datasheet @)
B},{’ ¥ calibri -l | == @ = New X Totals 4l L? 7 Selection - \;a .

A |B S UEEE . Aetrean = Save 7 speling | §) ot V) Advanced - euiten cing =
fiew ste = i=|[at2 efres ilter witc in

o SO Rl = === E=1E=] I - | % Delete - B More - Windows ~ i
Views ||Clipboard & Font e Rich Text Records Sort & Filter Vindow Find

Minimizing the Ribbon

H_J

Sort & Filter gallery

You can double-click any Ribbon tab to minimize the Ribbon and display more of the Access
screen if desired. Single-click any tab to temporarily display all options for that tab. Double-

clicking again, displays the full Ribbon.

You can also minimize the ribbon from the Quick Access Toolbar.
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Quick Access Toolbar

The Quick Access Toolbar can be modified to include tools you frequently use. This
eliminates the necessity to navigate to another tab to perform a task. To add a tool:

Click the El from the toolbar - and select from the options available.
OR
Right-click a tool, and select Add to Quick Access Toolbar.

LE:;"Z ! Calibri = |11 -

; Add %Quick Access Toolbar

" Customize Quick Access Toolbar...
Vie
Show Quick Access Toolbar Below the Ribbon
ol Minimize the Ribbon

Opening an Existing Database

We will explore an existing database to become familiar with the various components of
Access. Follow these steps to open an existing database.

1. Click the Microsoft Office button @ from the upper-left corner of the Access window.

Recent Documents
119043.mdh

19043.accdb
“Acess Practice 2007.accdb

J/ Cpen

Open [Ctrl=0}

4 ... \Northwind Practice 2007 .accdb
Marthwind Practice 2007.accdb
‘Documents and Settings'...\19043.mdb
‘w.\Datasheets I- Create a table by...

darketing projects.accdb

[ £ =T [ T SV (R I VI [, B B =S | WY [ S |

M
Faculty.accdb

P
]"'Il Manage »

| 2] Access Options ||X Exit Access |

2. Select from the Recent Documents, if available, or click Open and navigate to the drive or
folder to locate the database you want to open.
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3. When security levels are set to the default and/or if the database contains macros, the
following Security Warning displays.

A v Access Practice 2007 : Databa)

.
[(La
—
- Hame Create External Data Database Toals

=

(= = =||||:= 25| | o
e | e 2 |[B A ]S {222 R0 === [i=(i=| |2
Views ||Clipboard ™= Font Rich Text

)

Q Security Warning Certain content in the database has been disablg Opti-:-nQ

4. Click Options

—

Microsoft Office Security Options

@ Security Alert

VBA Macro
Access has disabled potentially harmful content in this database,

If you trust the contents of this database and would like to enable it for this session
only, dick Enable this content.

Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.

More information

File Path:  C:Y,..ice 2007 Class Files\Office 2007 Class Files\Access Practice 2007.accdb

() Help protect me from unknown content {recommended)

@ g

Open the Trust Center I Ok l [ Cancel ]

5. If you trust the owner of the database, select Enable this content, and click OK.

Note: This Security Alert message displays if the database contains macros, modules, or
action queries. The practice database we use in class is located at the IT Training
website: http://www.carlsonschool.umn.edu/oitcourses Select the Microsoft Access 2007
course description to download the practice file. The practice file contains macros;
however, macros and modules are outside of the scope of this class.
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Exploring a Database

We will explore components of an existing database to help you become familiar with the
features of Access.

The screen below displays the Tables object expanded, and the Categories table open.
éq d i Table Tools Access Practice 2007 : Database (Access 2007) - Microsoft Access - X
o) -
7/‘ Home Create External Data Database Tools Datasheet L2
=i N : o Mz ion - a
b Calibri h === A = New X Totals %l Lri' 7 Selection }3 2 Replace
— ) Ee) =& save & speliing | %) V] Advanced ~ = GoTo~
v'Ift-\- Paste 3 B I U A - & - |@v‘ H - Rel;.flrlevsh X Delste - = More - Filter gale Filte Find I Select
Views || Clipboard T Font {F Rich Text Records Sort & Filter Find
Al Access Objects - 4(— =1 categories | £
Tables & '\.Eaiegnn,l—l-v/ta‘legory Nam - Description - Picture - |Add New Field
E categories % g ! Beverages Soft drinks, coffees, teas, beers, and ales Bitmap Image
BB customers 2 2/ Condiments Sweet and savory sauces, relishes, spreads, and seasoning Bitmap Image
+ 3 Confections Desserts, candies, and sweet breads Bitmap Image
j Employees
= 4 Dairy Products  Cheeses Bitmap Image
B3 Order Details P -
+ 5 Grains/Cereals | Breads, crackers, pasta, and cereal Bitmap Image
E ordars + 6 Meat/Poultry  Prepared meats Bitmap Image
= Produds g 7 Produce Dried fruit and bean curd Bitmap Image
B shippers 2 8 Seafood Seaweed and fish Bitmap Image
B3 suppliers (New]
EA switchboard tems
Queries ¥
Forms ¥
Reports ¥
Macros ¥
Modules ¥

Opening an Object

To open an object, locate it in the Navigation pane; then double-click to open. A tab displays

for the open object of Access as the above example shows.

Database Objects

The Navigation Pane displays the various database objects. You can expand or collapse the
views of these objects to display the information you need.

Tables As mentioned earlier, tables are the main component of a database. Tables can be
viewed either as a datasheet or in design view. Pivot tables and charts are also
available, but are outside the scope of this course.

Queries You must create queries yourself. For instance, you might want to perform a query
to find out if there were any expenses for meals that exceeded $50.00.

Forms Forms are closely associated with tables. When you use a form, you view one record at a
time. When you use a table in datasheet view, you view as many records as can fit on
your screen.

Reports You can create reports to display the information you specify. Reports are typically
used for printing.

Macro A macro lets you perform a series of tasks by issuing one command.

Module Modules are similar to macros, but more complicated, and require some programming

knowledge. (Macros and modules are outside the scope of this course.)

Copyright © 2008, Carlson School of Management, University of Minnesota 7
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Using the Navigation Pane

Many viewing options are available from the Navigation Pane and can be somewhat confusing

to those new to Access 2007. Two suggestions are provided below.

Click the drop-down button and select Object Type and All Access Objects to display a view
like the one below. You can use the expand buttons to view all the objects of a certain type.
To expand an object, e.g., to view all tables in the database, click the expand button
next to that object type. You can also collapse the Navigation pane, if desired.

All Access Objects -

Mavigate To Category
Custom

v  Object Type
Tables and Related Views
Created Date
Modified Date
Filter By Group
Tables
Queries
Forms
Beports
Macros
Modules

w | All Access Objects

OR

HY)
—-/ Home

Views | Clipboard M

¥

Create

Extern

by
(=}

All Access Objects

Sl [R5

Tables

N/

Queries

Forms

Reports

Macros

Maodules

Rl I I -4

Click to collapse
the Navigation
pane

Expand button to
view all tables in
database

Under the Filter By Group option, select the object type you want to view to display a view like
the example below. The Table object is selected and changes the view to display all tables in

the database.

Tables 'T“

Mavigate To Category
Custom

»  Ohject Type
Tables and Related Views
Created Date
IMadified Date

Filter By Grou

< ~  Tables
v

Queries
Forms
Reports
Macros
Maodules

All Access Ohjects

to view

ETab

les

15 0 0

Categories
Customers
Employees
COrder Details
Crders
Products
Shippers

Suppliers
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Working with Existing Tables

Many people who use Access never create a database. One or two people may create a
database; then others enter data, perform filters and queries, and create reports. It is
important, however, to understand how a database works. For this reason, we are going to
begin by studying an existing database to see how the tables were set up.

Opening a Table
Follow these steps to open a table in an existing database.
1. Open the appropriate database.

2. Select Tables from the objects available on from the Navigation pane. A list of tables in
this database display on the right side of the window.

3. Double-click the table you want to open. Access opens a new “tab” and the table displays
in Datasheet view, similar to an Excel spreadsheet.

~ -

(Da) o Table Toals Access Practice 2007 : Database (Access 2007) - Microsoft Access - 7 X
= Home Create External Data Database Tools Datasheet @
LEZ Calibri Ta . | ﬂ = New X Totals | 4] LT W7 Selection ~ \]3“:} 2 Replace
R £ 2| Bsave P speling | %) Y] Advanced ~ = GoTo~
View Paste s B LU ||A |2 -|[E-| |22 - | RELI‘r‘evsh  Delete - E=I More - Filter » Find .
Views | |Clipboard ™ Font fa Rich Text Records Sort & Filter Find
Tables v | « ||EH categories { T Customers | *
EH categories Customer| ~ Company Name - Contact Name - Contact Title -
e — # ALFKI Alfreds Futterkiste Maria Anders Sales Representative Obere Str. 57
B Employees # ANATR Ana Trujillo Emparedados y helados Ana Trujillo Qwner Avda. de la Cony
; + ANTOMN Antonio Moreno Taqueria Antonio Moreno Qwner Mataderos 2317
B order Details = AROUT Around]the Horn Thomas Hardy Sales Representative 120 Hanover Sq
B orders # BERGS Berglunds snabbkop Christina Berglund Order Administrator Berguvsvdgen §
B3 producds ¥ BLAUS Blauer See Delikatessen Hanna Moos Sales Representative Forsterstr. 57
ER shippers # BLONP Blondel pére et fils Frédérigue Citeaux Marketing Manager 24, place Kléber
T cupplicrs 3 BOLID Bolido Comidas preparadas Martin Sommer Owner C/ Araquil, 67
+ BONAP Bon app' Laurence Lebihan Qwner 12, rue des Bouc
E switchboard items # BOTTM Bottom-Dollar Markets Elizabeth Lincaln Accounting Manager 23 Tsawassen Bl
*] BSBEV B's Beverages Victoria Ashwarth Sales Representative Fauntleroy Circt
E CACTU Cactus Comidas para llevar Patricio Simpson Sales Agent Cerrito 333
* CENTC Centro comercial Moctezuma Francisco Chang Marketing Manager Sierras de Granz
F CHOPS Chop-suey Chinese Yang Wang QOwner Hauptstr. 29
3 COMMI Comércio Mineiro Pedro Afonso Sales Associate Av. dos Lusiadas
3 CONSH Consolidated Holdings Elizabeth Brown Sales Representative Berkeley Gardel
# DRACD Drachenblut Delikatessen Sven Ottlieb Order Administrator Walserweg 21
¥ DUMON Du monde entier Janine Labrune owner 67, rue des Cing
4 EASTC Eastern Connection Ann Devon Sales Agent 35 King George
# ERNSH Ernst Handel Roland Mendel Sales Manager Kirchgasse 6
# FAMIA Familia Arguibaldo Aria Cruz Marketing Assistant Rua Ords, 92
# FISSA FISSA Fabrica Inter. Salchichas 5.A.  Diego Roel Accounting Manager C/ Moralzarzal, i
3 FOLIG Folies gourmandes Martine Rancé Assistant Sales Agent 184, chaussée d
Fl FOLKO Folk och fa HB Maria Larsson owner Akergatan 24
# FRANK, Frankenversand Peter Franken Marketing Manager Berliner Platz 4: |
Record: 4 < Lofsi | > Wt [ i [ [search | e S—— ] T T o
Unigue five-charactar code basad on oufimes

e Each record displays in a row in the table.
e The field names display at the top of each column as a heading
e The record number of the selected record displays in the lower-left corner.

¢ Navigation buttons display in the lower-left corner to assist you in locating other
records.

e To move to the last record, click |»1.

e To move to the first record, click .. (See next page for more navigation)

Copyright © 2008, Carlson School of Management, University of Minnesota 9
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To move forward one record at a time, click _*_.

To move backward one record at a time, click 1_.
¢ To move to a specific record, type the record number in the field, and press Enter.
e Toadd a new record, click [*#].

e Use the scroll bars to view additional fields or records.

e To view information in related tables, click the expand button # to the left of the record.
Click =l to collapse the information. (See page 13 for information on relationships.)

Working with Records in an Existing Table

You can easily add records, delete records, and sort records in an existing table.

Adding a Record

Use any of the following methods to add a record to the table.

e From the buttons on the lower-left corner of the table window, click [¥#,

¢ From the Home tab of the Ribbon, click the New Record button .

¢ Right-click in the shaded area on the far-left side of the table window to select a row or
record, and select New Record.

e From the last field of the last record, press Tab.

Deleting a Record

To delete a record, select the record(s) you want to delete by selecting the record(s) in the far
left shaded column. The selected record(s) is highlighted. Then perform any of the following
procedures.

e Press the Delete key.

}( Delete -

e From the Home tab, click the Delete Record button
¢ Right-click in the left shaded column and select Delete Record.
The Microsoft Access dialog box displays.

Microsoft Office Access E|

You are about to delete 1 record(s).

! If vou dlick Yes, wou won't be able to undo this Delete operation,
Are wou sure you wank bo delete these records?

ues | [ Mo ]

Click Yes to delete the record(s).

Note: If the record you want to delete is related to records in another table, a screen displays
to indicate that this record cannot be deleted.

10 Copyright © 2008, Carlson School of Management, University of Minnesota
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Sorting Records
You can easily sort records in a table by one column using the buttons on the Home tab.

Simply click in the column by which you want to sort, and click the appropriate Sort button.
Sorting by more than one column must be done in a query. See page 44.

& ( \'f/’SeIecti-:nn'
Zz
A
x

7:] Advanced ~
Filter )

7 g9
Sort & Filter

To remove a sort, click the Remove all Sorts button 4.

Tabbed Viewing

A new feature in Access 2007 is tabbed viewing. If you open more than one object in your
database, multiple tabs display for each open object. Multiple objects open are shown in the
example below. You can move from one object to another by simply clicking the tab.

D_ﬂ\ = o Table Toals Access Practice 2007 : Database (Access 2007) - Microsoft Access - O X I
fj/ Home Create External Data Database Tools Datasheet CI|Ck to
LE/{’ 1 Calibri = P === @ =i New X Taotals El \f// Selection ~ \}a 2ac Replace Close
ﬁ — EE] — =& save F speting | %) _ V9 Advanced - ) = GoTo~ aCt|Ve
nfw Paste ; B I U A - & - |@v| EH - = =% Rilrlevsh  Delete = 5 More - Filter R Find g Select - -

R | e : : = : object tab.
Views | Clipboard ™= Font [F} Rich Text Records Sort & Filter Find

l;] Security Warning Certain content in the database has been disabled Options.. 3 tabS dlsplay fOI’ Open ObjeCtS 23 /

All Access Objects v «|| 3 customers | =] oOrderData.. | I Employees | €] ﬁ)

Tables £ Employee | - |Last Nam - |First Nam - Title « |Title ¢ » Birth Date - | Hire Date - Address N

B categories 4 ! Davolio Nancy Sales Representative  Ms. 08-Dec-1968 01-May-1932 507 - 20th Ave. E.

=1 Customers e 2| Fuller Andrew Vice President, Sales  Dr. 19-Feb-1952 14-Aug-1992 908 W. Capital Way

=1 Employees + 3 Leverling  Janet Sales Representative  Ms. 30-Aug-1963 01-Apr-1992 722 Moss Bay Blvd.

+ 4 Peacock Margaret  Sales Representative  Mrs. 19-Sep-1958 03-May-1933 4110 Old Redmond Rd.

& order Detais % 5 Buchanan Steven | Sales Manager M. 04-Mar-1955 17-Oct-1993 14 Garrett Hill

= orders + 6 Suyama Michael Sales Representative  Mr. 02-Jul-1963 17-Oct-1993  Coventry House

E Products e 7 King Robert Sales Representative  Mr. 29-May-1960 02-Jan-1994 Edgeham Hollow

=1 shippers + 8 callahan Laura Inside Sales Coordinato Ms. 09-Jan-1958 03-Mar-1994 4726 - 11th Ave. N.E.

= + 9 Dodsworth Anne Sales Representative  Ms. 02-Jul-1969 15-Nov-1994 7 Houndstooth Rd.

Closing a Tab

Right-click on the tab you want to close and select Close or select Close All to close all open
tabs in your database.
OR

Click the Close button %! for the selected object.

Changing Column Widths

You can adjust the width of a column by clicking the border of a column heading. When your
mouse displays as a *t*, click and drag to the appropriate width.

Copyright © 2008, Carlson School of Management, University of Minnesota 11
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Viewing a Table in Design View

You can view a table in the Datasheet view or you can use the Design view. The Design view
allows you to see how the fields were set up in the table. Follow these steps to view a table in
Design view. We will discuss more information about table design beginning on page 19.

1. Open the database and table you want to view.

Vd

View

2. From the Home tab, click the View button | _viw

View
or click and select Design View.

The design view for the selected table displays. Note the W_Tl Primary key symbol.
Primary keys are a vital part of an Access database and will be discussed beginning on
page 17.

5 categories | =] Customers h

Field Name Data Type Description
Text Unigue five-character code based on customer name.
CompanyMName Text
ContactMame Text

] » €

3. To return to the datasheet view, click the View button again or click and select
Datasheet View.

Saving Changes to a Table

Whenever you add or delete records in a table, those changes save automatically when you
close your table. However, if you have made other changes to the display that you want to
save, such as sort order, or column width, or added new fields, you will need to save those

changes. Click the Save button @ on the QuickAccess toolbar. If you close your table
without saving, the following screen displays. Click Yes if you want to save those changes.

—

Microsoft Office Access

! E Do wou wank ko save changes to the design of table "Customers'?

| =] | [ Mo ] [ Cancel l

Closing a Table

Right-click on the tab for the table you want to close and select Close or select Close All to
close all open tabs in your database.

OR

Click the Close button %! for the selected object.

12 Copyright © 2008, Carlson School of Management, University of Minnesota
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Introducing Relationships

The most efficient databases contain multiple tables. Those tables can then be related to each
other. When you create a database using the database templates (see page 14), Access
automatically creates relationships for you. You can also modify relationships yourself. (See

page 30.)
For now, we want to explore relationships and what they mean. To view the e AL
relationships in a database, click the Database Tools tab, and click the =E |&°
Relationships button. A screen displays indicating the relationships between A Sl
elationships
the tables. Cig
% Show
j Categaries _'3' Ilelationship;.\'-.\ x
.:u_gtgzlf;iw_[[) x P Order Details é
CompanyMame ‘2 -Ol-'der[D g O.I'dé\'[D o
ContactMame CustomerID EI D.?:F“D Products
ContactTitle EmplayeelD Q”u'an't'ﬁ ? ProdudiD =
Address CrderDate Disc-:uur;t PraductMame
C\t\,-'. RequiredDate SupplierlD
Region ShippedDate CategaryID H =
ShipVia QuantityPerUnit
- UnitPrice
Shipers Uniistoc
En‘ép:;n;p_l;;'ee[D - @ SRIEEE
LastMame Companyhame
Firsthiame Fone
Title
TitleOf Courtesy Categories
BirthDate ¥ CategonD
HireDate CategoryMame
et Description

< [

Picture

Suppliers
¥ SupplierlD
CompanyMame
ContactMame
ContactTitle
Address
City
Region

[

-

»

In the example above, the tables are related through the primary keys. (See page 17 for
information on primary keys.) The line from one table to another shows the field that is used

to relate the tables. The “1” and

o0

indicate that these relationships are “one to many.” This

means, for instance, that one customer could place many orders, etc. Relationships will be

discussed in more detail later in this class. (See page 30.)
(=
When finished viewing relationships, click the Close button.

Viewing Relationship Information from a Table

When viewing a table, you can click the Expand (+) and Collapse (-) " H
buttons to view related records in other tables. L\\m

Closing a Database

Click the Microsoft Office button

Clase

Customer| =

NATR

and click Close Database.

Copyright © 2008, Carlson School of Management, University of Minnesota
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Creating a Database

You can create a database from scratch or use a Database template. If you create a database
from scratch, you can include only the components you need. Access can also create a
database for you with the Database templates. This creates tables, forms, and reports for

some typical kinds of databases,

Good Database Design

such as asset tracking, contact management, expenses, etc.

There are some basic concepts that should be used when designing your own database.
Now that you are somewhat familiar with some of the components, we can cover these.

Lay out a draft of the tables and fields you will need on paper (similar to a flow chart)

before constructing your database. This is the most important suggestion. This will help
you to see what information relates to other information, and will assist you in creating

relationships and determining

enable you to form relationshi

primary keys.

You should have a unigue primary key. Primary keys help keep records in order and

ps.

Creating a Database with an Access Template

Note: This information is provide

d for reference only. Access has a number of templates

available to help you get quickly started. However, it is important to understand the basics of
database design so that you can modify the template to suit your needs. For this reason, we
will focus on designing your own database so that you will have a clearer understanding of

how modifications can be made.
To use an Access template:

1. Click the Microsoft Office button, and select New. The following screen displays.

(x™ Microsoft Access - X
2 D ©
Template Categories
Featuring . . . .
a1 Getting Started with Microsoft Office Access
Local Templates
Tem plate From Microsoft Office Online New Blank Database -
Options
Blank Database
le Featured Online Templates
n-prof s o, —
g | q
e | S 4
Nl l S’ v </ -
- \J Q \7/3/-
Assets Contacts Issues Events
by of— Blank Database
u , § 9 of— r + off
L o=
= N g =
i) Mepr " More on Office Online: inistrats
£aOffice Online Training | Templates | Downloads i
What's new in Access 20077
J e T
GE:
- er ,
i tn Py P
Ready
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2. Select the desired option:

e To download a “featured” template from Microsoft, select Featuring from the left-hand
Navigation bar and select the desired option from the main area of the screen. Click
the Download button on the right side of the screen.

e To create a database from one of the templates installed on your computer, select
Local Templates and select the desired option.

e Toview and download additional templates available from Microsoft, select From
Microsoft Office Online. Click the Download button on the right side of the screen.

A new database will be created and saved in the default location on your computer. This new
database may contain forms, reports, and queries, as well as relationships.

Creating a New Blank Database

To help you have a clearer understanding of the components of an Access database, we will
create a blank database in class so that we can customize fields and create our own primary
keys and relationships.

O
1. Click the Microsoft Office button L=~ , and select New.

New Blank Database

2. Click Blank Database.

Blank Database

3. The right side of your screen displays a field to enter the new database name, as well as
navigate to the location where you would like to save your new database.

Blank Database

Create a Microsoft Office Access database that does
not contain any existing data or objects.

File Name:

batabase1.accdb =
C:\Documents and Settings\Comp Administrator My
Documents',

[ Create l [ Cancel ]

4. Enter the database name in the File Name: field. For our class exercises name the
database Carlson School.

5. If you want to save the database in an alternate location, click the L—_1 and navigate to a
different drive and/or folder to select the desired location.

N
Note: Clicking L—_1 allows you the option to save in an alternate format, such as Access
2000, which may be desirable if sharing your file with others

6. Click the Create button.

Copyright © 2008, Carlson School of Management, University of Minnesota 15



Microsoft Access 2007 Overview

7. A new database is created and opens with a table with no fields or records.

Creating Tables

Access 2007 has made it easier to create basic tables. Using the Design view (see page 19)
allows you additional options. To create a table: o) | -

— Haome Create

FIE

Table SharePoint
k emplates = Lists =

Tables

1. Activate the Create tab and click the Table button.

2. A new table displays with no fields or records. A “Table
Tools” tab displays at the top of the Access screen with tools available for customizing
and creating your tables.

4

[ | & Table Taols Qprlson School : Database (Access 2007) - Microsoft Access - =
3
—/ Home Create External Data Database Tools

@
== J E"FJ' i Insert | Data Type: - Unique ?Kﬁ H‘ﬂ
1 Format Is Required =l =)
d Existing Loakup Relationships Ohject
Fields Column —jR name $ % Dependencies
Wiews Fields & Columns Data Type & Formatting Relationships
N
All Tables v | «|| T Table1 5
Tablel # ID - |Add New Field
3 Tablel : Table #* (New)

Creating Tables by Adding Fields from Templates

You can use the above view and add new fields that have been custom-designed by
Microsoft.

1. Click the New Field button. A new pane displays on the right side of the screen with a
variety of table field templates from which to choose.

) = i TableTools | Carlson School : Database (Access 2007) - Microsaft Access -

@ x

-4 < Create External Data Database Toals Datasheet

\ ‘j =8 i Inset | DataType: B 7 Unique =
S I .

AddfExisting Lookup .. -
ields  Column =0 Rename || § %

Views Fields & Columns Data Type & Formatting Relationships

=
All Tables « | <« || =3 Tabler X | Field Templates x

Tablel % D ~ |Add New Field Select one or more fields to insert into your table.
£ Tablel : Table * (New) =l Basic Fields o
Single Line of Text

Multiple Lines of Text

You can also right- .
click and select et T
Rename. Press tab i
to next new field. Sk
Demepion
Category
Condition
Acquired Date
Purchase Price

Current Value
Location
Manufacturer
Model
Comments
Attachments
Retired Date
= Contacts
Company
Last Name
First Name
E-mail Address
Job Title
Business Phone
Home Phane
Record: M < Lofl v & Search Mabile Phon

Datasheet View I =163
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¢ The Basic Fields category has general field types as are available when working in
the Design view of your table.

e The other categories have customized field types that you can easily add as
appropriate for the type of data you want to track. You can combine fields from
any of the options available.

2. Double-click the fields you want to add. The new fields display at the top of your table.

Renaming a Field

If you added a field such as “Single Line of Text” you can rename the field by right-clicking the
field name and selecting Rename. Type the new name in the high-lighted field area.

Field Names

Field names can consist of up to 64 characters, including letters, numbers, spaces, and any
special characters except a period, exclamation point, accent grave ('), or brackets. Spaces
are allowed but not as the first character.

Note: Access allows you to use spaces and many of their new customized table templates
also use spaces in their field names. However, we recommend that you do not do so. Use an
underscore or upper and lower-case letters to define your field names, such as First_Name or
FirstName. Anyone wishing to use VBA code will be more successful using these field
naming suggestions.

Tip: If you want your field names to appear as though they have spaces, you can modify the
"Caption” in Design view. This will be covered on page 22 .

Primary Keys

A primary key is not necessary in a single table, but is important when relating tables to each
other. A primary key should be a field that contains unique information that could not be the
same for more than one record in that table. Some possible examples for a primary key are
Student IDs, corporate employee numbers, social security numbers, customer numbers,
purchase order numbers, etc. Only one record could have these unique numbers. Primary
keys that MIGHT work would be phone numbers or addresses. Fields that would NOT work
are names, birth dates, product numbers, etc. as multiple records could have the same
information. By default, Access creates a primary key for you as the first field in your table as
an auto numbered field. You can set your own primary key from the Design view. This will be
covered on page 20 .

Saving a Table

When finished adding fields to your new table, click the Save button =l on the Quick Access
toolbar. The following dialog box displays.

Table Mame:
Tablel

[ Ok ]I Cancel I

Enter the desired table name and click OK.
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**Exercise 1

Create and save a table called “Departments.” Allow Access to use the ID field as a primary
key. Use the “Single line of text” field type and rename each field as below. Save your table;
then enter the following data into your table.

DepartmentID Description

HRIR
IDSC
MBA
MBT
FINA

Human Resources and Industrial Relations
Information and Decision Sciences
Masters of Business Administration
Masters of Business Taxation

Finance

**Exercise 2

Create another table to track benefactor information. You can use the Contacts template for
some of the field types. Create your table with the following fields:

FirstName

LastName Company ContributionDate Amount ThankYouSent Website
(Yes/No)

Save your table as “Benefactors.” After saving your table, enter a fictitious contact for a
company, and enter a real website to test how that field responds.

18
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Creating a Table in Design View

When you create a table in design view, you have the most control for customizing the table,
and therefore customizing your database. In this class we will look at some of the features
you can customize in design view. Follow these steps to create a table in design view.

1. Click the Create tab, then click Table Design.

—-’J Haome Create External

= B8 /&

Table Table SharePaoin|

Table
Templates =  Lists = \ Design
Tables

N
(Note: You can also click Table; then switch to design view by clicking the View button.)

The Design tab opens and the Table Tools tab displays at the top of your screen.

- Home Create External Data Database Tools

E]j u§‘ v Insert Rows
¥ Delete Rows
View || Primary Builder Test Validation
Key Rules =20 Lookup Column

Views Tools

Tables ~| <« [|Z5] Tabler

() = - Table Tqdls =~ Access Plpctice 2007 : Database (Access 2007) - Microsoft Access

B categories Field Name Data Type
Customers |

Employees
Order Details
Orders
Products

Shippers

s

Suppliers

Field Properties

General |Lookup

s

A field name can be up to 64 characters long,
including spaces. Press FL for help on field
names,

Design view. F6 = Switch panes. FL = Help.

R

2. In the Field Name column, type a field name. (Example: LastName) Field naming tips are
available on page 17.

3. Press Tab to the Data Type column. A drop-down box provides a variety of data type

options. We will practice a few of these in this class. See page 22 for explanation of field

types.

Optional: In the Description area, enter a description. This information displays on the

Status bar at the bottom of the Access screen when entering information into the table, or

when using a form

4. Press Tab again to return to the Field Name column to enter another field.

Copyright © 2008, Carlson School of Management, University of Minnesota
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5. Repeat steps 2 and 3 until all fields are entered. (You can modify and/or add more fields
later.)

6. Click the Save button @ on the Quick Access toolbar. The following dialog box displays.

7. Type a name for your new table and click OK. If you have not designated a primary key,
the following dialog box displays.

=

Microsoft Dffice Access

There is no primary key defined.

! E Although a primary key isn't required, it's highly recommended. A table must have a primary key for you ko define a
L relationship between this table and ather tables in the database.
Do you wank bo create a primary key now?

[ ves | ’ Mo ] [Cancel ]

8. To have Access designate a primary key, click Yes. Your table is saved.
or
To designate your own primary key, click Cancel and proceed as instructed on below to
set your primary key. Your table won't be saved until you designate a primary key and
follow the steps to save again.
or
To have no primary key at this time, click No. Your table saves without a primary key.

Specifying a Primary Key

As mentioned earlier, a primary key must be a field that contains unique information that could
not be the same for more than one record. Some possible examples for a primary key are
Student IDs, corporate employee numbers, social security numbers, purchase order numbers,
etc. Only one record could have these unique numbers. When you create a table using
templates as described on page 16, Access creates an auto numbered primary key.

However, when you have an internal option for your organization, such as an employee
number or a customer ID, you may want to specify that as your primary key. Follow these
steps to assign a primary key.

1. Open or create the table for which you want to specify a primary key.

2. If necessary, From the Home tab, click the View button

or click and select Design View. The design view for the —=
selected table displays.

3. From the left side of the design view screen, click the shaded area next to the field you
want to designate as the primary key.

4. Select the field you want for your primary key by clicking the shaded area next to the field.
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h‘;
Prim 34”\'\5‘

5. Click the Primary Key button from the ribbon. L%

;’tg;,:,‘-. d9- = Table Tools ~ Access Practice 2007 : Database (Access 2007) - Microsoft Access - 7 X
) -
—/ Home Create External Data Database Tools Design (7]

‘:]j h‘; Zransert Rows ;ﬂ g‘_/‘
- =5 Delete Rows S
view ||[Primary| Builder Test Validation Property Indexes
Key Rules ‘l'.‘ﬂ Lookup Column Sheet
v Tools Show/Hide
Tables ~| « (| =] Table1 o2
E5 categories Field Name Data Type Description -
s
B 9 ployeelD Text E
FirstName Text Enter legal name
00 employzes LastName Text
EH  order Details Address Text
= orders City Text
State Text
B Products .
Zip Text
B shippers WorkPhone Text
= suppliers HomePhone Text
-
Field Properties
General |Lpokup
Field Size 255 A~
Farmat
Input Mask
Caption
Default Value
Validation Rule Afield name can be up to &4 characters long,
Validation Text including spaces, Press F1 for help on field
Required Mo et
Allow Zero Length Yes
Indexed Yes (Mo Duplicates)
Unicode Compression Yes
IME Mode Mo Contral
IME Sentence Mode Mone
Smart Tags ~
Design view. F& = Switch panes. F1 = Help. H o8 (D e

Note the W_?l Primary key symbol next to EmployeelD in the example above, indicating
that this is the primary key for this table and no duplicates will be allowed for this field.

Note: This button acts like a toggle switch. You can change the primary key by selecting
a different field, then clicking the button again. You cannot change a primary key once a
relationship has been created. Remember, primary keys must be unique.

6. Save your table as described previously.
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Customizing Data Types for a Table

When working in the Design view, there are many things you can do to customize the type of
data entered into the fields. We will look at some of these options in this class. Click the =1in
the Data Type field to select the desired option.

Data Type: Description:

Text Used for any field that won’t be used for calculations.
General entries up to 255 characters.

Memo Used for 255 — 64,000 characters.

Number Used when needed to perform math and when you don’t
need currency. For other numbers such as telephone or
social security numbers use Text. Formatting can be
done via Input Masks (bottom of the screen). Sometimes
used to enforce number input.

Date/Time Used for entering dates.
Currency Used for entering currency. Can also be used in
calculation.

AutoNumber  Used when you want Access to number records for you.
Often used as the Primary Key.

Yes/No Used as a check box to indicate when something has
been done.
OLE Used for pictures, sound files, etc.

Attachment New to Office Access 2007 .accdb files. You can attach
images, spreadsheet files, documents, charts, and other
types of supported files to the records in your database,
much like you attach files to e-mail messages. This is
only available in the .accdb file format.

Hyperlink Used for web sites or “mail to” email addresses.
Lookup Used to select from a “pick list” you create in the table or
Wizard to select from another table. Follow the steps on the

wizard to create your pick list. See page 27 for
instructions.

Additional formatting of fields can be done in Field Properties area at the bottom of the design
view. This is outside the scope of this class. Press F1 for assistance with formatting options.

Note: If you want a field name, such as FirstName, to display as First Name (with a space),
enter the text as you want it to display in the Caption field of the Field Properties area when in
Design view.

22 Copyright © 2008, Carlson School of Management, University of Minnesota



Microsoft Access 2007 Overview

**Exercise 3

Create a Table in Design View

Create and save another table called “Majors.” Set the Primary Key as Major. No “auto-
numbered” field is needed as there will be no duplicates in this table.

Major

Accounting

Finance

Human Resources and Industrial Relations

Marketing

Supply Chain Management

**Exercise 4

Changing the Primary Key

Open your Carlson School database. Open the Departments table in design view. Change the
primary key to DepartmentID. Delete the auto number ID field. Save the table.

Note: You cannot change a primary key for tables that are already in relationships. You may

need to remove the relationship, change the primary key, and then re-establish a relationship.

**Exercise 5

Create a Table in Design View

Create another table called Courses. Make the Course Number the Primary Key. Make the
Credits field a “number” field.

CourseNO  |CourseName Credits

MBAG6030 Introduction to Principles of Accounting 4
MBA6315 Ethical Environment of Business 3
IDSC6441 Introduction to Electronic Commerce 4
ACCT3001 Managerial Accounting 4
HRIR3021 Human Resource Management and Industrial Relations 4

Creating a Table Using Excel Data

You can import Excel data to a new table in Access. For instance, if we already had an Excel
file listing the student data, we could import that table into our Carlson School database.

Importing the Data

1. Open the Access database to which you want to add data.
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Create External Data

2. Click the External Data tab; then click Excel. 5 A Textrie

The following dialog box displays. For this class we ;
will select Import the source data into a new table in the current database. Other options
are available.

Get External Data - Excel Spreadsheet &

Select the source and destination of the data

Specify the source of the data.

Ele name: ¢:\Documents and Settings\Comp Administrator|y Documents|,

Specify how and where you want to store the data in the current database,

—_— (%) Import the source data into a new table in the current database.
If the specified table does not exist, Access will create it. If the specified table already exists, Access might overwrite its contents
with the imported data. Changes made to the source data will not be reflected in the database.

() Append a copy of the records to the table:
If the specified table exists, Access will add the records to the table, If the table does not exist, Access will create it. Changes made
to the source data will not be reflected in the database.

() Link to the data source by creating a linked table.

Access will create a table that will maintain a link to the source data in Excel. Changes made to the source data in Excel wil be
reflected in the linked table. However, the source data cannot be changed from within Access.

Cancel

3. Click Browse to locate the file you want to import into your database; then click Open. (For
this class, import the Students table.)

4. Click OK. The Import Spreadsheet Wizard displays.

& Import Spreadsheet Wizard x
Your spreadsheet file contains mare than one warksheet or range. Which worksheet or range would you like?

(®) Show Worksheets
() show Named Ranges

Sample data for worksheet 'shest1’.
1 fFtud ID First

T T O T

T

T
W Ry Ghon R kD

in

Fau Claire I
Fau Claire I
. Faul I
ux Falls D

(ST I ¥ RV (¥ v}
1in Ko

on

mext> | [ Ensh |

24 Copyright © 2008, Carlson School of Management, University of Minnesota



Microsoft Access 2007 Overview

If necessary, select a different worksheet or named range and click Next.

= Import Spreadsheet Wizard

Microsoft Access can use your column headings as field names for your table. Does the first
row specified contain column headings?

irst Row Contains Column Headings

[ VT v (T
5

T
[LIN R

T

LA TR ¥ I R ¥

[ Cancel ] [ < Back ] [ Mext = ] [ Einish ]

Indicate whether the first row contains column headings, and click Next.

& Import Spreadsheet Wizard

‘fou can specify information about each of the fields you are importing, Select fields in the area below. You can then modify field
information in the 'Field Options' area.

Field Options
Field Name: |l Data Type: |Text v
Indexed: Yes (Duplicates OK) w [] Do notimpart field {Skip)

StudentID [Fi L Lddress

TR

T

T
G Gs K3 Ga n RY (n R

10 R oin
T

T
(SRR

T

L R ¥ s R T VI R )

[ Cancel ] [ < Back ] [ Mext > ] [ Finish ]

If desired, modify field names; then click Next.
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8. Indicate your preference regarding a primary key; then click Next.

= Import Spreadsheet Wizard

Microsoft Access recommends that you define a primary key for your new table, A primary key is used to
= uniquely identify each record in your table, It allows you to retrieve data more quickly.

L RETEEEERH
2 H Han R
F
2 HH Han R
LR

(O)Let Access add primary key.

ghnnsem'rn primary key. |StudentlD ~

StudentID State [Zip
I 3527 =
) F5122 :‘
ED FO0355
I 3513
I 3527
NI 3527
I 5122
D FO355
NI [F3513
I F3527
NI F3537
S P3122
G F0353
1 53513 -
b
[ Cancel ] [ < Back ] [ Mext > ] [ Finish ]

9. Enter a name for your imported table, and click Finish.

& Import Spreadsheet Wizard

That's all the information the wizard needs to impert your data.

Enter the desired

/ table name
Import to Table:

[] 1 would like & wizard to analyze my table after importing the data.

(ow ) (s

Note: If desired, you can save your import steps if you frequently import the same type of

data. This will eliminate using the steps in the wizard.
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Using the Lookup Wizard

You can use the Lookup Wizard when you want to provide a drop-down list for people to use
when entering data. This can be done using an existing table or by entering data directly. To

create a field using the lookup wizard:

1. Create your table in design view.

2. Inthe Data Type field, select Lookup Wizard. The following screen displays.

Lookup Wizard

This wizard creates a lookup column, which displays a list of values
you can choose from, How do you want your lookup column to get
itz values?

@I want the lookup column to look up the values in a table or
‘query,

O 1 will type in the values that T want.

3. For this exercise, select | want the lookup column to look up the values in a table or

query; then click Next. The following screen displays.

Lookup Wizard

Which table or query should provide the values for your lookup
column?

: Customers
1 Employees
! Order Details
: Orders

! Products

: Shippers

: Suppliers

View

@Iables () Queries (@] Both

Cancel ] [ < Back ] Mext =
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4. Select the desired table; then click Next. The following screen displays.

Lookup Wizard

Which fields contain the values you want included in your loakup
column? The fields you select become columns in your lookup
column,

Available Fields: Selected Fields:

’ Cancel ] ’ < Back l Mext = ]

.. to add the field to the
Selected Fields area, and then click Next. The following screen displays.

Lookup Wizard
What sort order do you want for the items in your list box?

You can sort records by up to four fields, in either ascending or descending order.

==
: =

’ Cancel ] ’ < Back ] Mext > l

6. Set a Sort order, if desired; then click Next. The following screen displays.

Lookup Wizard
How wide would you like the columns in your lookup column?

To adjust the width of a column, drag its right edge to the width you want, or double-dick the
right edge of the column heading to get the best fit.

Hide key column (recommended)

Category Mame
Beverages
Condiments
Confections
Dairy Products
Grains/Cereals
Meat/Poultry
Produce -

] »

[ Cancel ] [ < Back I MNext = ][ Finish ]

Note: Although Access recommends to Hide the key column, this may not be appropriate
for data such as employee ID or student ID, etc.
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7. Click Next. The following screen displays.

Lookup Wizard
What label would you like for your lookup column?

Do you want to store multiple values for this lookup?

[ allow Multiple Values

Those are all the answers the wizard needs to create your lookup
column,

[ Cancel ] [ < Back ]

8. If desired, change the label for the lookup column.
9. If desired, select Allow Multiple Values (for instance, students could have a double major).
10. Click Finish. The following dialog box displays.

Lookup Wizard

! E The table must be saved before relationships can be created. Save now?

[ oves | ’ ) ]

11. Click Yes to create the relationship. Relationships will be covered in more detail
beginning on page 30.

**EXxercise 6

Modifying Tables — Students Table and Courses Table

You can modify your tables to add existing fields or change field types (if no data has yet been
entered). As indicated by Exercise 4, you can change the primary key of a table IF it doesn’t
destroy existing relationships. Using Access 2007 you can add new fields from either the
table view as instructed on page 16 or from the design view as instructed on page 19.

1. Open the Students table in Design View

2. Add the field “Major.”

3. Use the Lookup Wizard to add this field, allowing you to select from the list of majors in the
Majors table.

4. Open the Courses table in Design View.

5. Add a field called “Department.”
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Creating Relationships

A good database has multiple tables, and those tables relate to each other. If you use the
database wizard to create a database, relationships are automatically formed. Also, when we

used the Lookup Wizard to fill in information in our Students table, a relationship was

automatically formed. Most relationships are “one to many.” In our exercises, for instance,
one student can take many courses. One course can have many students enrolled, etc. Itis
also possible to have “one to one” relationships and “many to many” relationships, but those

are outside the scope of this class.

Viewing / Modifying Relationships

Follow these steps to view the existing relationships in a database.

1. Open the database you want to view.

2. Toview the relationships in a database, click the Database Tools tab, and
click the Relationships button. A screen displays indicating the relationships
between the tables. You can view the relationships in your database and also

create or modify relationships.

Database Tools

= o
==
=| =7 d
Relationships
Ul

% Sh-:n-r:

Students R
I students: Table

Dﬂ\ =] - Relationship Tools | Database? : Database (Access 2007) - Microsoft Access
l
—/ Home Create External Data Database Toals Design
_ ¥ Clear Layout -L,:j - Hide Table
S = [ Relationship Report g’jDilect Relationships ]
Edit Show ' X . Close
Relationships Table 33:All Relationships
Tools Relationships %
; -
All Tables = « || =7 Relationships '
Majors 3
= majors : Table Majors Students
® Major # StudentlD -

First
Last
Address
City
State

Zip

4

3. To edit an existing relationship, simply double-click the connecting line. The Edit

Relationships dialog box displays.

Table/Query: Related Table/Query:
Majors + | Students
Major » Major
-
E ; Create Mew.,
[CIEnforce Referential Inteqrity:

Relationship Type: Cre-To-Many
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4. If desired, select Enforce Referential Integrity. This prevents deleting a record that is

related to a record in another table.
5. Click OK.

Creating New Relationships

When you want to create a relationship between tables, you must first show the tables in the

Relationship windows.

1. Open the database you want to view.

2. To view the relationships in a database, click the Database Tools tab, and
click the Relationships button to view the Relationship window

3. Click the Show Table button
or
Right-click in the Relationship window and select Show Table.

/D'a\, =] 3+ Relationship Tools | Database2 : Database (Access 2007) - Microsoft 4
o
Home Create External Data Database Tools Design
P X Clear Layout Hide Table E
== [28) Relationship Report B0 Direct Relationships
Edit e o Close
Relationships o3: All Relationships
Tools Relationships
All Tables v <« || =7 Relationships
Majors & -
EH Majors : Table Majors . Students
? Major ? StudentlD -
Students ES First
E students: Table Last
Add
Departments # Cit‘.ress
55 Departments : Table ctate

Benefactors & Zip
B3 Benefactors: Table

4

Courses &

EH courses: Table

4. The Show Table dialog box displays.

Show Table 2x

Tables | Queries || Both

‘Benefactors
Courses
Departments
Majors
Students

Add l ’ Close

Database Toals

=5 &°
Sz d
Relationships ~

I
% Show
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5. Select the tables you want to relate; then click Add.

OR

Double-click the tables you want to add. The tables are added to the Relationships

window.

Eﬂ\l = - &)= Relationship Tools | Database2 : Database {Access 2007) - Microsoft Access - 5 X
- Home Create External Data Database Tools Design I

= [25) Relationship Report gj Direct Relationships

j/(’ ¥ Clear Layout -,_Fi =& Hide Table Q
Sh

Edit ow - . . Close
Relationships Table 33 All Relationships
Toals Relationships
All Tables + « || = Relationships
Majors ES
1 Majors : Table Majors . Students Departments Courses ]
? Major ? studentlD - ¥ Department ID ¥ CourseMo
Students ES First Description CourseMame
EH students: Table Last Credits
Address Department
Departments E city B
ﬁ Departments : Table St;te
Benefactors ES Zip -
B Benefactors: Table
Courses ES
I courses: Table

6. Click and drag the field from one table that you want to relate to another table. See
example below. Remember that one of the fields needs to be a primary key.

Departments Courses
¥ Department ID ¥ CourseMo
Description CaurseMame
Credits
Department

The Edit Relationships dialog box displays.

Edit Relationships

D ——
Create

Table/Query: Related Table Query:

Department ID ¥ | Department A

Join Type..
- : Create Mew..
[IEnforce Referential Integrity:

Relationship Type: Cne-To-Many

7. If desired, click Enforce Referential Integrity.
8. Click Create.

9. When finished, close the Relationship window.
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Creating a Form

Forms make it easy to enter information into your database. If you create your own table, you
will probably also want to create a form. There are several ways to create forms. We will use
the easiest way in this class. Forms allow easy data entry and viewing one record at a time.

1. Open the table for which you would like a form.
2. From the Create tab, select Form.
CCEECEENE
—/ Home Create External Data
= &3 [0 &
Table Table SharePoint Table
Templates =  Lists=  Design
Tables
A new form displays in Layout view.
!‘/65-3\\ = & )= Form Layout Tools Database2 : Database (Access 2007) - Microsoft Access - =2 X
= Home Create External Data Database Toals Format Arrange 'Q)
| A - =- | | =] Titl
E Calibri -1 -mg“ ijﬁl @ = j—‘% ZJ;; . jﬁl
view || 1 u||E=E = [ 5| Conditional || [F§ e 1 (%581 508 Glidvlinesg,' Loga %Dateandﬂmag'idt::iiﬂ;;m
Views Font Formatting Gridlines Controls AutoFormat
All Access Objects = = Students“{ﬁl Students x
Tabl S
% e;eneiar:turs E StUdents
B3 courses
ez Departments T = .
& Majors  StudentiD: [CsoM1001
= students !
Forms £ First: John ‘
% Benefactors
Last: Canniff ‘
Address: 523 Hanson Drive ‘
City: Eau Claire ‘
State: ‘WI ‘
zip: |53597 |
Major: ‘ v‘
Record: K (1of18  » Wb [ R [[search
Layout View ==
3. If desired, click an alternate format from the AutoFormat buttons.

Note: When in Layout view, you can adjust column widths, and add a custom logo, if

desired.
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4. When finished making adjustments, click the View button and select Form View.

— -
= Calibri
view'||B 7 U|/g
-
==
==t | Layout View
[—=]
% Design View
The new form displays. New records can be added or edited.
N A - DR Database2 : Database (Access 2007) - Microsoft Access - o x
1 i) —
- | Home | Create External Data Database Tools @
== = & = = = : =i New Z Totals ?l Wz Selection 2.c Replace
£ e === =5 (g ol o
53 =8 save 7Spelllng Al EAd\ranced = = GoTo~
Vi Past ¢ = i= = |lah Refrash Filt Find
o o 7 B 7 oAl ||— | EEES iﬂe.s X Delete ~ = More i 7) P Toggle Fifter " lg select -
Views | Clipboard M Font [5 Rich Text Records Sort & Filter Find
Tables #
=1 Benefactors StUdents
E1 courses
=1 Departments 3
= Majers StudentiD: CSOM1001
T students
Forms ® First: John
El Benefactors
Last: Canniff
Address: 523 Hanson Drive
City: Eau Claire
State: Wi
Zip: ‘5359?
Major:
Record: M 1 of 19 oMb | & Mo Filter | Search |1 " il 3
Eocm View ] ==

Navigation buttons and a Search feature are available from the Status bar at the bottom of
the form.
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Creating Reports

A report provides a more professional display of the information contained in the tables.
Reports display current data at the time they are run. There are several ways to create
reports. One way just creates a report from one table or query. A great new feature of
Access 2007 is the ability to create a report in Layout view. Using the Report wizard allows
you to combine fields from multiple tables and applies a specific format. The Design view of
reports allows additional options, but is outside the scope of this course.

Creating a Report from a Table

Follow these steps to create a report from a table. All fields in the selected table will display in
the report. If necessary you can remove or resize fields in Layout view (see page 36).

1. Open the database for which you want to create a report.
2. Select or open the desired table; then from the Create tab, select Report.

Create External Data Database Toals
7] @ - g R fi3) PivotChart G
— = __|Blank Form —
SharePoint Table Form Split Multiple Faorm
Lists *  Design Form  Items _EI Mare Forms ~ pesign

les Forms

3. Access immediately creates an attractive report from your selected table. The report
displays in the new “Layout” view.

4. To view the report as it will print, click the View button (from the Home tab); then select
Print Preview. Tip: Add Print Preview to your Quick Access toolbar. (See page 5.)

§|:| Calibri
E

Ml =
Ml 1=
&l o

| =

View
-

E Report View

I

E Layout View

L@Z Design View

Using Print Preview, you can move from page to page, or use the new Zoom feature to
see how your report will print.

Page: 1 I E | B | T ] C
4 'EEREI e 0 (+)
Navigate from page Use new “zoom”
to page button to zoom in or
out.

When finished with Print Preview, click the Close Print it
Preview button from the right side of the Print Preview tab. ;-:[-\ie:_?
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Creating a Report in Layout View

A new feature in Access 2007 is the layout view for reports. This is an easy-to-use view and
allows you to select specific fields to display in your report, rather than include all fields as the
previous option displayed. You can even select fields from related tables.

1. From the Create tab, select Blank Report.

Create External Data

1 & B

SharePaoint Table Form
Ir Lists~  Design
biles

Database Tools

E N fiz7 PivotChart E m=m| [3 Labels i

Trrie—m| 2 . £

= ] Blank Form = f_| Blank Rgport| ==

Split  Multiple Form Report & Report

Earm tems E‘_E| Maore Farms - Design Eg\ Report Viszard Design
Farms Reports

L

A blank report displays.

2. From the right side of the screen, in the Field List area, select Show all tables.
Field List *
Mo fields available to be added to the current
view,
Er’ Show-all tables
3. Click the + to expand table fields.
Field List x
Fields available in other tables:
=] Categaries Edit Table
% CategorylD
CategoryMame
Crescription
Picture
+] Customers Edit Table
+] Employees Edit Table
+ Order Details Edit Table
¥ Orders Edit Table
+ Products Edit Table
¥ Shippers Edit Table
+ Suppliers Edit Table
4. Double-click the fields you want to add to your report. If you want to add fields from a
related table, expand that table to display additional fields.
When finished, click the X to close the Field List.
If desired, click and drag the column borders to resize them on your report.
f
Category Name Product Name Unit Pricej Units In Stock |
Beverages Chai $18.00 3af
j =+
Beverages Chang 519.00 : 17
Beverages Guarana 54.50 EDE
Fantéstica : :
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Combining Creating a Report from a Table and Layout View

When you create a report from a table, Access creates a header, but not when you create a
table in Layout View. Although this could be added in Design view, an easier option is to
create your report from the “main” table that contains the fields you want. Then, click Add
Existing Fields (from the Format tab of the Report Layout Tools tab). You can then add
additional fields from other related tables.

Da) H 2 - s Report Layout Taols Access Practice 2007 : Database (Access 2007) - Micro

i)

J/ Home Create External Data Database Tools Format Arrange Page Setup

E y . (A}l £ Totals e | W

E B I U . =2 B0 153 Hide Details K]

View —— $ % Group Gridlines Logo Add E| sting| || AJtoFormat
- === v = & Sort — :{J:) i -

Views Font Formatting Grouping & Totals Gridlines ContridNs AutoFormat

You may be prompted to create a relationship.

Specify Relationship

Choose & table to relate Products’ to: Categaries A

How do you want to relate 'Products’ to this table?

This field in 'Products'... Relates to this field in 'Categories'. ..

CategoryID W <::> LategoryID
¥ =

() One record in ‘Products’ matches one record in 'Categaries'

(") Manvy records in ‘Products’ match one record in 'Categaries'

(") One record in ‘Products’ matches many records in 'Categories’

[ OK ]’ Cancel ]

Select the appropriate fields and relationship type, and click OK.

Delete a Report Field from Layout View

If desired, you can delete a field from the report in Layout View, if it is not necessary. Below, the
Category ID field is selected. By pressing the Delete key, it will be removed from the report.

= -
i Categories
F '
| Category ID | Product \Ian‘ﬁ%% Category Name Description

1 ;Chai Beverages Soft drinks,

Below is the new report view without Category ID.

i : {
= Categories N
Product Name Category Name Description
Chai Beverages Soft drinks, coffees, teas, be
Chang Beverages Soft drinks, coffees, teas, be
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Modifying the Design — Customizing the Logo

Creating a report in this way displays a default design and default logo. If desired, you can
add your own logo or select a different format.

While in Layout view, click the Logo button from the Ribbon and select a logo file from your
computer.

Report Layout Tools Database? : Database (Access 2007) - Microsoft Access
hal Data Database Tools Format Arrange Fage Setup
A | r":[_"—l Z Totals - @ = Ejg
iy - £ SN 155 Hide Details ==
Conditional | % 2 2 .0 .00 | FGroup Gridlines Add Existing
=n . A=A e sort £ Fields
Farmatting Grouping & Totals Gridlines
£ Students V-5 StudentJ il students Logo
Insert a picture into your form or
report to be used as a logo.
L sartay, Marg
8 | students ]
StudentID First Last

Switch to Print Preview to view your design changes.

CSOM1001 John Canniff
CROMI1002 Esther Nelson
CEROMI1003 Sarah Anderson
CROM1004 Steven Johnson
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Grouping Options in Layout View
Access 2007 has made it easy to group your report.

1. Create your report from a table or using the Layout View as described above.
2. Activate the Report Layout Tools tab; then select Group & Sort.

__J\ [ ¥ Access Practice 2007 : Database {Access 20..(¥ Report Layout Toals
]

—-/ Home Create External Data Database Tools Add-Ins Format Arrange Page Setup

i= A &) Totals ~ == o B =~ 'I@ m

- T - _ . 3

3 B 339 Hide Details B R = =

View Font $ 9% 9 =0 .00) Group Gridlines Logo = Add Existing || AutoFormat
- - | & sort - & 59 & T Fields -

Views Formatting Groyfing & Totals Gridlines Controls AutoFormat

A Group, Sort, and Total area displays at the bottom of your report to add grouping
options.

3. Inthe Group on area, select the desired field from the drop-down list.

Group, Sort, and Total

§|Grou|:| onB}egoryﬂame ¥ with Aon toe/'r More "3 qa I }<|
Te=Add 2 group ||% ) Add asort

4. For additional options, such as grouping items of the same category on one page, select

More, to display additional grouping options.

~~ | Click to

Group, Sort, and Total t’ close

Group on CategoryName ™ with Aontop ™ « by enﬁ'alue ¥ ¢ withno totals ™ » a1 grouping
with tite Category Mame , with a header section ™ » out a footer section ™ - OptiOﬂS

keep whole group together onone page ™ + Less

[£= Add agroup |4 ] Add asort

5. When finished making changes, click the Closing Grouping Dialog Box button X in the
upper right corner of the Group Sort, and Total area of the report screen.

6. If desired, click the View button and select Print Preview.

Creating a Report Using the Report Wizard

You can also create a report using the report wizard. Click the Create tab, and select Report
Wizard. You can select from several related tables or queries.

~ 3 —

Access Practice 2007 : Database (Access 2007) - Microsoft Access = X

éﬂ/)‘ —
— Horg pal Data Database Tools Add-Ins 1L7]]

-il E J @ é g P fij3] PivatChart CI %ﬂ = Labels E @E @ J

- :_l Blank Form — i f_| Blank Report ==
Table Table SharePoint Table Form  Split Multiple Farm Repaort - Report Query Query Macro
Templates~  Lists~  Design Form  Items %IM'"E Forms = pesign REPO'%“ZB'U De)ign || Wizard Design -
Tables Forms R Other

Run through the wizard selecting the desired options to create your report.
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Queries and Filters

You can use filters or queries to locate records and information. Filters are temporary.
Queries are saved so that they can be performed repeatedly. You may want to create a
guery, and then use that query to create a report for a more attractive option.

Filtering Records

Access provides some simple ways to filter one table. You can use buttons on the ribbon to

filter information.
1.

2.

Open the table you want to filter.

A drop-down list displays the filtering options for that field.

Click in the field containing the information by which you want to filter.

From the Home tab, click the Filter button or click the Filter button El above any field list.

Takle Tools Access Practice 2007 : Database (Access 2007) - - = X
@l Data Database Toals Add-Ins Datasheet 'Q)
11 - | ﬂ = New X Totals Al X7 Selection = &a L e
=E = = | | =B save & speling | %) 19 Advanced = =
= :=||ak Refresh Find
{ ¥ e
|EH- || B - == Il ™= | % pelete - B More ~ " Toggle Filter g ~
Font ] Rich Text Records Sort & Filter Find
j Customers x
Company Name - Contact Name - Contact Title (T\ )
# Alfreds Futterkiste Maria Anders sales Represen| 4] | SortAtost
# Ana Trujillo Emparedados y helados Ana Trujillo Owner Z|| sertZtoA
+ Antonio Moreno Tagueria Antonio Moreno Owner &
# Around the Horn Thomas Hardy Sales Represen )
. o o Text Filters »
# Berglunds snabbkdp Christina Berglund COrder Administ
+ Blauer See Delikatessen Hanna Moos Sales Represen [5elect Al i
. i P ) ; v
# Blondel pere et fils Fredérigue Citeaux Marketing Man (Blanks)
A _ , Accounting Manager L
+ Bglido Comidas preparadas Martin Sommer Owner Lssistant Sales Agent E
# Bon app’ Laurence Lebihan Owner Assistant Sales Representative
+ Bottom-Dollar Markets Elizabeth Lincoln Accounting Ma Marketing Assistant
+ B's Beverages Victoria Ashworth Sales Represen Marketing Manager
+ Cactus Comidas para llevar Patricio Simpson Sales Agent Order Administrator ™
) - ) ) v] o
# Centro comercial Moctezuma Francisco Chang Marketing Man [< ] wner i |[ >]
# Chop-suey Chinese Yang Wang Owner
| Comércia Mineiro Pedra Afonsa Sales Associate I 211 | [ cancat |
+ Consplidated Holding Elizahath Brown Sales Benregamn

4. Select the desired options, and click OK to display your filtered results.

5. To filter by additional fields, click in the field by which you want to filter and apply

additional filters, as described

above.

: . . . - .
Note: Filtered fields display with a button next to the field name. The Status bar at
the bottom of the screen also displays a button when filters have been

applied.

40
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Filtering by Selection

If you want to filter by a portion of a field, e.g., Sales to display all Sales Representatives,

Sales, Agents, Sales Managers, etc. follow these steps.

1. Select the text by which you want to filter.

2. Click the Selection button, and select the desired filtering options.

\li:/f Selection "|

; a
ii +ac
i

Begins With "Sales’

[oes Mot Begin With "Sales’
Contains "Sales’

Does Mot Contain "Sales’

Toggling Filters

After applying a filter(s), you can toggle the results to again display the entire list. Click the
"\ iteres

Toggle Filter button. OR, click the

button from the Status bar at the bottom of

the screen.
j«g\l = 9 - v Table Toals
fj/) Home Create External Data Database Tools Add-Ins Datasheet 'Q)
b Calibri -1 ~ | c=E= . = New T Totals =l
Lb”ﬁ, A |||B I U|E=E EF _-_ = :T g =8 Save & speling || &1
e 7 A -S| ||| - (5= RE;_|r|evSh X Delete ~ E More ~
Views || Clipboard & Font F} Rich Text Records
Removing a Filter 4] sortatoz
. . 21| sotZtoa
When you no longer need a filter, you can remove it. Al sazto
% Clear filter from %ntacﬂitle
1. Click in the field where the filter is applied. v | Text Filters v
_ _ BT [ (select 2
2. Click the Filter button . [ telanks)
|:| Accounting Manager
3. Click Clear filter from field name. L] Marketing Assistant
[1 marketing Manager
[ order administratar
wner
Note: You can also click the Advanced button and select [ sales Associate
Cleal’ A” Filters |:| Sales Representative
T Advanced = _ =T [ Ok ) [_cancel
% | Clear All Filters
\I@ Filter By Form
¥_ Apply Filter/Sort
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Creating Basic Queries

You may also want to perform queries to locate specific records. For instance, you may want
to find out students who have not yet paid their tuition. When you create a query, you can
save it and perform it again. Saving a query saves the question — not the answer. We can
assume that the results of the student tuition query would have different results nearly every
day. There are many types of queries — this class covers a few of them.

Creating a Query in Design View

A query selects records based upon select criteria. Follow these steps to create a query in
design view.

1.

From the Create tab, select Query Design.

Lists =  Design
bles

Create wternal Data

SharePoint Table Form

Database Tools Add-Ins
N fi) PivotChart fzm| [ Labels =
] E
jBIanIr. Form Ern 3 EJ Elank Report ]
Multiple Form Report Report

Split
Form

Items

_'3_:;‘| Mare Forms ~ peasign
Farms Reports

K=, Report Wizard Design || Wizary Design

The Show Table dialog box displays.

Show Table

Tables | Queries || Both

(Cateqgories

Customers
Employees

Order Details
Orders

Products

Shippers

Suppliers
Switchboard Items

[

Add

J |

Cloze ]

Double-click each table you want to include in the query (or select the tables, and click the

Add button).

42
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3. Click Close, the Query screen displays.

D_ﬁ\ = H QueryTools | Access Practice 2007 : Database (Access 2007) - M - B X
] -
7j Home Create External Data Database Tools Add-Ins Design L]

E 1' Iﬁ - ' d::' /d' ﬁ : ' @D Union Gp= TralnsertRows 7§ Insert Columns I Property Sheet

H He e e A : ﬂ Delete Rows S =
‘.‘ Pass-Through Delete Ro *' Delete Columns |:ﬂ Table Names
View Run Select | Make Append Update Crosstab Delete Show . Totals F
- Table ,ﬁ, Data Definition Table '\ Builder ‘L’EI Return: |All - T21 Parameters
Results Query Type Query Setup Show/Hide
x

@ Security Waming Certain content in the database has been disabled Options..,

All Access Objects -« |3 quem1’ x

Tables 3

= categories Categories Products =
x * N
= customers % categonID % Productd
= employess CategaryName ProductMame
’ Description SupplierlD
FH  Order Details Picture CategonyD
51 orders QuantityPerUnit
UnitPrice L |

E Products e

A Shippers

E3 suppliers

1 switchboard Items

Queries ¥

Forms ¥ i1

Reports v ol 0000000000000 L4

Macros ¥ ‘ : =

Field: v
¥
Modules ¥ e %
Sort:
Show: O O O O O
Criteria:
ar

4. To add the fields you want to use in the query, double-click them to display them in the
query grid area. (Note: You can also click and drag them to the desired area of the grid.)

&

5. To view the query results, click the View button.
!
Run
Note: You could also click the Run button for a basic query. However, the Run button

will perform an “action” for some queries, such as deleting records, appending records,
making a table, etc. We will not create any action queries in this class.

7

&L

View I
6. If necessary, click the View button L—_1 or click View and select B2 pesion vew

Design View to modify your query.

Saving the Query

Once you have completed the query, you should save it for future use.

1. Right-click the tab above your query, and click Save (or click the Save button.) | =l
The Save As dialog box displays.

Save As

Query Name:

Queryl

2. Enter the desired query name, and click OK. Tip: Name queries with QRY as a prefix to
distinguish them from tables when creating additional queries from queries.
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Adding Criteria to a Query

If you want your query to only show specific records, you can either apply filters (which do not

save) or apply criteria to your queries so that the query is saved to display exactly the results
you want.

1. Create a query as previously described.

2. Inthe Criteria area of the query grid, enter the desired criteria. In the example below, the
results would only display the inventory for Beverages where the Unit Price is greater than
20. Note: Itis NOT necessary to apply quotes as displayed around Beverages below.
Access applies the punctuation for you when you move to a new area of the grid. Also,

although prices display with currency symbols, Access requires only numbers be entered
for the query below.

| =4 Inventory ' x
F
Categaries Products E|
7 a ProductMame
¥ categorylD —\_ SupplierD
CategoryMame ez CategoryID
Description QuantityPerUnit | =
Picture UnitPrice
UnitsInStock
UnitsOnCrder  w
i
4 [ »
Field: | CategoryMame ProductMame UnitPrice UnitsIinStock =
Table: | Categaries Products Products Products =
Sort:
Shaowr: |
—— P> Criteria Eeverages =20
ar

Sorting in a Query

If you want to sort by more than one field, apply criteria in the Sort field. Sorting occurs left to
right, so you should add fields in the order by which you want to sort.

Using the Query Wizard

You can also use the Query Wizard. However, if you want to apply specific criteria, you will
need to use the Design view.

1. From the Create tab, select Query Wizard.

@ﬂernal Data Database Tools Add-Ins
IE ar ; 5 ji PivotChart En:. =l Labels i
J_ = = = g _ ] Blank Form = E f | Blank Report ==
I | "2 AR G ore o - S| "7 R meport e SEE,
bles Forms Reports
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The New Query dialog box displays.

New Query

isimple Query \Wizard

Crosstab Query Wizard

Find Duplicates Query Wizard
Find Unmatched Query Wizard

This wizard creates a select query
from the fields you pick.

I OK ][ Cancel ]

Select the desired query type. For this class, select Simple Query Wizard, and click OK.
If you select other options, you will have different views than those below when completing

fields to the Selected Fields.

the wizard.
In the Tables/Queries field, select the table or query you want to use.
Simple Query Wizard
Which fields do you wantin your guery?
You can choose from more than one table or query.
Tables/Queries
Table: Customers v
Available Fields: Selected Fields:
CompanyMame 1
ContactMame
ContactTitle
Address
City
Region
PostalCode kd
]
4. Inthe Available Fields: area, select the fields you want to use and click the appropriate
button to add those fields to the Selected Fields: list.
5. To add fields from other tables or queries, select another table or query and add additional
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6. Click Next. The following screen displays.

Simple Query Wizard
Which fields do you want in your query?

You can choose from more than one table or query.

Tables/Queries

Table: Order Details hd

Available Fields: Selected Fields:

i s -
Quantit ContactMame
Discount OrderDate
OrderID
ProductID
[ Mext = l ’ Einish

7. Click Next. The following screen may display.

Simple Query Wizard

Would you like a detail or summary guery?

ag @® iDetail (shows every field of every record)
| |-----
o () Summary
oo
de
1 | a3
2 |as
! [4]4]
4 | cc
5 | dd
| dd
’ Cancel ] [ < Back ” Mext = l ’ Einish l

Note: If you select Summary, select Summary Options and select the values you want
calculated; then click OK. Note: See Crosstab Queries and Calculating Queries below for
more effective options.

8. Click Next.
9. Enter atitle for your query; then click Finish.

Note: To add criteria to your query, such as only customers from a specific country, you must
go into the Design view.
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Parameter Queries

You can use parameter queries to prompt the user to enter criteria for selecting records. You
could, for example, create a query that prompts the users to specify certain dates or perhaps

certain countries. This allows you to create one query with “parameters” rather than multiple

gueries. You can create a parameter for a hew or existing query.

1. From the Create tab, select Query Design.
OR,

If using an existing query, open the query; then click the View button to display the design

view of the query.

2. Place your cursor in the Criteria are for the field you want to use as a parameter (e.g.,

Cagetory)Type a question or message to prompt the user. The question must be
enclosed in square brackets (e.g., [Which category?] or [Enter category])

) 9 - s Query Tools | Access Practice 2007 : Database (Accd
Ej !
—/I Home Create External Data Database Tools Add-Ins Design
']j w @ = ' El::' ﬂ E 5 ,' D Union op= SlInsertRows g Insert Columns
i ™ . ﬁ .
. _I. s w0 - OPass-Thr-:ugh =" Delete Rows ﬁ Delete Calumns
View  Run Select | Make Append Update Crosstab Delete o Show . -
- Table M‘Data Definition Tahle \ Builde h_._i'm Return: Al s
Results Query Type Query Setup
All Access Objects ~ « || quem1
Tables = B
£ categories Categories Products
* * N
B customers ? CategonyID = ? ProductD
j Emplayees CategaryMName ProductMame
Description SupplierlD
EH Order Details Ficture CategorylD
F orders CuantityPerlUnit
UnitPrice 2
j Products Ce e
= Shippers
=z | Suppliers 3
FH switchboard Ttems
Queries #
i Quarterly Crders by Product
3 Alphabetical List of Pradu...
4
'ﬁj Category Salesfor200y | fiii———o ————mmam
'ﬁ] Current Product List Field: | CategoryMame ProductMame QuantityPerlnit UnitPrice
Table: | Categaries Products Products Products
'ﬁ:‘ Employee Sales by Country Sart:
'ﬁ:‘ Invaices tho"‘"
Critegfa: | [Which category?]
'ﬁ] Invaices Filter R
3. Click the View button (or save and open your query) to view the prompt.
P "
Enter Parameter Value .R
Which category?
[ Ok, ] [ Cancel
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4. Enter the desired category, e.g., Beverages, and click OK to view the results of your
query.
5. If necessary switch to design view to make changes. When satisfied, right-click the Query

=l

Whenever you open this query in the future, you will be prompted for the appropriate
parameter. This means that it is important to know the data in your tables.

tab (or click the Save button and save your query as described earlier.

Creating a Range Parameter Query

You can create a parameter query that specifies a range of numerical information such as
guantities or dates.

1. Create a new query or open an existing query in Design view.

2. Paosition your cursor in the Criteria area of the field you want to use as a parameter, e.g.,
Order Date.

3. Type BETWEEN [prompt message] AND [prompt message]. Using order date for

example, type:
BETWEEN [First date] AND [Last date].

-_:;‘- = 1 = Query Tools | Access Practice 2007 : Database (Access 2007) - M - = X
) =
—/ Home Create External Data Database Tools Add-Ins Design (7]

"]j I' @ :J' EE:I' /4' ﬁ "\ ' QD Union = WElnsertRows g Insert Columns Z & Property Sheet

F o~ j:l ; ’—|
b b L 9 ‘ Pass-Through = Delete Rows "AP Delete Columns % Table Mames
View  Run Select | Make Append Update Crosstab Delete . Show . - Totals "5
- Table wZ, Data Definition Table °;\ Builder A3l Return: | Al [z] Parameters
Results Query Type Query Setup Show,/Hide
- <

All Access Objects v «||H quenyt =
Tables 2 B - -
B categories Order Details Orders =

* * -]
E Emplayees 7 OrderiD = L 9 orded
EA Order Details % ProduciD CustomerID

UnitPrice EmployeelD
B orders Quantity CrderDate
j Products Discount RequiredDate

ShippedDate o

j Shippers -

ez Suppliers

B switchboard Ttems 3

B customers

Queries E

='_5,=:| Alphabetical List of Produ...

L

=‘_!,=:| Current Product List

Ly »
dD  Customers and Suppliers.. | |[———7M—MMMMMMMM
='_5'=:| Employee Sales by Country Field: | ProdudiD OrderDate Quantity

Table: | Order Details Orders Crder Details
E5 Invoices Filter L Sort:
251 Order Details Extended izt O O
Criteria: Bel»\-een [First date] And [Last date]

=‘_!,=:| Order Subtotals or
1= - P TGN PP Y

4. Click the View button to preview the prompts. The first Enter Parameter Value dialog
box displays.

Enter Parameter Value
First date
I

o< ] [ cone

48 Copyright © 2008, Carlson School of Management, University of Minnesota



Microsoft Access 2007 Overview

5. Type the appropriate information and click OK to display the second Enter Parameter
Value dialog box.

6. Enter the appropriate information for the second prompt box and click OK.

If desired, save the query as described previously.

Creating a Formula in a Query

You can perform simple calculations in a query to calculate values from different fields. For
instance, you can display the total amount due for the number of items ordered.

1. From the Query Design view, type the name for your field, e.g., Total, then a colon, then
the field name you want to use in your calculation in square brackets, enter your operator,
(e.g., +, -, *, etc.) then the next field name in square brackets. For example:

Total: [UnitPrice]*[Quantity]

The example below would give you the total amount due for the number of items ordered.

e A [ s  Tot Access Practice 2007 : Database (Access 2007) -M - = X
I _ N Query Tools (
—/ e eate ExterData Datab Tools A 5 Daﬁp;'r]n 'Q_ﬁ)
‘]j I‘ = ' EE:I' ﬂ ﬁ \ ' QD Union “p= -=InsertRows f Insert Columns % Property Sheet
i ™ ﬂ ; z
o J L ==l * .‘ Pass-Through = Delete Rows lP Delete Columns % Table Mames
View  Run Select | Make Append Update Crosstab Delete o Show N\ Bui 5 Totals £
- Tahle ,ﬁ.Data Definition Tahle &= Builder 11,21 Return: |All = =] Parameters
Results Query Type Query Setup Show/Hide
All Access Ohjects v« || 53 quemya | ES
Tables 2 =
- Order Details Orders =
22| Categories Order Detail Ord
* * I
E employees 7 OrderD = 7 orderd
; ¢ Produ ustomer]
£ order Details % ProductD Cust D
UnitPrice EmployeelD
3 orders Quantity OrderDate
iscoun equiredDate
E3 Produds bi t Eh' i ddDDtt
ippedDate L
j Shippers St
B Suppliers
T3 switchboard Ttems 3
H customers
Queries *
3 Alphabetical List of Pradu...
h
=j:| Current Product List
o [ »
@D Customers and Suppliers .. | |[V—n—uw ——————— wwmmm
=‘_:|=:| Employee Sales by Country Field: |OrderDate Cuantity UnitPrice Total: [UnitPrice]*[Quantity] =
_ ) Table: | Orders Crder Details Crder Details @
jj Invoices Filter L Total: |Group By Group By Group By Group By
. Saort:
B Crder Details Extended
= Show:
=j:| Crder Subtotals Criteria:
ar
=|!=l:| Products Above Average P..

Totaling a Column

Access now provides a tool to total a column in a table or query. | & Z:e é:t&'sn
Click the Totals button in the Records gallery. A new row Reteesn | S0 Er_:m "
displays at the bottom of the table view. .

Records

Click the drop-down field to select the desired

. Total
function.

Sum Click To ag

Average
Count
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Crosstab Queries

You can build crosstab queries to summarize data in a more compact format, making it easier
to read. The format displays with summary values, similar to a pivot table in Excel.

1. Create a query in Design view by adding the tables you want to summarize. For this

exercise, use Products, Orders, and Order Details.
Add the necessary fields to the design grid. (ProductName, ShipCountry, Quantity)
From the Query Tools tab, Design tab, select Crosstab.

-/E!g-_,\. =9~ ¥ Query Toals
—/ Home Create External Data Database Tools Add-Ins Design
B! et « AN o
» i"Pass-Thr-:lugh
View  Run Select Make Append Update |Crosstab| [Pelete o Show
- Table @Data Definition Tahle
Results Qu
The design grid displays the Crosstab field.
E’J\, = I = QueryTools | Access Practice 2007 : Database (Access 2007) -M - B X
—/ Home Create External Data Database Tools Add-Ins Design '9)
‘E @ ' I::J' j’ ﬁ ' @D Union -,_:3:;1 ZealInsert Rows 7 Insert Columns z % Property Sheet
J ' \‘ Pass-Through = De Rows 1*'” Delete Columns )_‘j Table Names
View  Run Select Make Append Update |Crosstab| Delete Show . -
- Tahle ﬁ{‘Data Definition Table °;\ Builder %l Return ['a] Parameters
Results Query Type Query Setup Show/Hide
All Access Objects » <« || Queryi
Tables 2 =
) Products Order Details 1 | Orders E|
j Categaries
* : * pea -
j Employees % ProductlD = % CrderlD - ShipMName
EH order Details zmdLl'_d'\I’;me ¥ Em_td:_dm ShipAddress
upplier] nitPrice ShipCity
E orders CategoryID Quantity ShipRegion
A Products S”_at:t_“yperur‘“ Discaunt ShipPostalCade
nitPrice — ShipCountry -
= Shippers SRR S {PLounty
j Suppliers
E3 switchboard Ttems 3
B3 customers
Queries %
=j:| Alphabetical List of Produ...
.
B Current Product List
5 Ly »
dD Customers and suppliers ., | |fb—>n—>=>————— ==
20 Employee Sales by Country Field: |ProductName ShipCountry PraductlD =
_ ) Table: | Products COrders Order Details @
jj Invaices Filter L 4 | Group By Group By Count
=j:| Qrder Details Extended Crossstab: )Qow Heading Column Heading Value
N St
fﬂ COrder Subtotals Criteria:
or
fﬂ Products Above Average P..,
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4. In the Crosstab: fields for each table, click the « and select the appropriate option.
e Where you selected Row Heading or Column Heading, select Group By.
e Where you selected Value, select the appropriate option (e.g. Count, Sum, etc.)

5. Click the View button to view the results of the Crosstab query.

Specifying Criteria for a Crosstab Query

You can view all records, as in the example above, or you can specify criteria for each field.
For example, perhaps you only want to see orders for particular countries.

1. Open the Crosstab query in Design view.

2. Place the cursor in the Criteria: area for the field for which you want to specify criteria

(e.g., ShipCountry).

3. Enter the desired criteria. (To enter more than one criterion for the same field, use the
arrow keys to enter other criteria, e.g. US OR Canada OR Mexico.)

Field:
Tahle:
Total:
Crosstab:
Sart:
Criteria:
ar:

ProductMame ShipCountry ProductiD
Products Crders Qrder Details
Group By Group By Count
Row Heading Column Heading Value

sa

Canada

Mexico

4. Click the View button to view the results of the Crosstab Query with the criteria applied.

Alice Mutton
Aniseed Syrup

3

1
Boston Crab Meat 1 2
Camembert Pierrot 3 2
Carnarvon Tigers 1 1
Chai 2 2
Chang 1
1

Chartreuse verte

EX=al

Product Mame - Canada ~ Mexico -~ UsA
3

11

L e e L I I L

Exercise 6

Create a Query to display the following information from the Access Practice Database:

a.

b
C.
d

— Create a Query

Customer Company Name (sorted Ascending)
Orders placed in 2007 (sorted Ascending)
Product Name

Shipped to USA

You should have 170 records.
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Access and Excel

You may want to export Access data to Excel where you can have more options to manage
numerical data. You may also, at times, want to import Excel data into an Access database.

Excel to Access

Earlier in this class we imported an Excel file into Access (see page 23).

Access to Excel

You can send tables, reports, and queries to Excel.

_, oi;\.__ H = Tab
-
Home Create External Data Database Tools Add-Ins D3
':;:I W Access 4| Text File vy Word
T 7 Foe | o
— | ¥ Excel #® XML File >/ | Sl | S " Text File
ave Saved Excel /SharePoint =
Imparts #[ SharePoint List .g_c;j More ~ Exports ; b More ~
Import Gp_jh

From the External Data tab, select or open the item you want to Export. Click the Excel
button from the Export gallery. The following screen displays.

Export - Excel Spreadsheet

Select the destination for the data you want to export

Specify the destination file name and format.

File name: | \Documents and Settingsknelson'Desktop \Emplayees. xlsx|

File formatl | Excel Workbook (= xlsx) v

Specify export options.

[ Export data with formatting and layout.
Select this option to preserve most formatting and layout information when exporting a table, query, form, or report.

QK ] [ Cancel
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5. Click Browse to select the location where you want to export the file.

6. If desired, change the file format.

7. Select any other options, and click OK.

8. Navigate to the drive and folder where you saved the exported file to open it.
Access to Word

You can also export Access tables, queries, or reports to Word.

Do) T Tab
- Home Create External Data Database Tools Add-Ins BE
':;':J W Access 4| Text File mm mm @

, ) am
— | x| Excel #® XML File »/ Slx S B, fle
Saved o Saved Excel SharePoint
Imports | #1[ SharePoint List e_'j Mare ~ Exports List ek More -
Import Export

Select or open the object you want to export, click Word, and specify the location as described

above.

Importing Excel Data to an Existing Access Table

If you have data in Excel you want to add to an existing table in

Access, follow the steps

below. Column and field names must match exactly to add Excel data to an existing Access
table. If you have a primary key, take care to ensure that no primary key numbers are

duplicated, or your data will not import.

Preparing the Excel File
1. Open the Access database to which you want to add data.
2. Open the table to which you want to add records.

3. Verify the field names in the table; then close the table.

1. Open the Excel file and change field names as appropriate. If necessary, delete

unnecessary fields and save your file.

Tip: You can name a range of cells to import new data to an existing table. Naming

ranges is covered in the Excel Intermediate class.
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Importing the Data
1. Open the Access database to which you want to add data.

II,J'EEE;\__II lﬂ = Tab
7
Home Create External Data Database Tools Add-Ins D3
':':j W Access 4| Text File ':':'/:J vy Word
b 7% . B/ | elx SO0 i
— aﬁ XML File —— - |~} Text File
Saved Saved Excel SharePoint =
Imports #[1 SharePoint List e_:;j Mare ~ Exports List ek More -
Import Export

2. From the External Data tab, in the Import gallery, click Excel.
3. Click Browse to specify the file location.
4. Indicate the table into which you want to import the data and click OK.

-

Get External Data - Excel Spreadsheet

2Je3

Select the source and destination of the data

Specify the source of the data.

Spedify how and where you want to store the data in the current database.

() Import the source data into a new table in the current database.

If the specified table does not exist, Access will create it. If the specified table already exists, Access might overwrite its contents
with the imported data. Changes made to the source data will not be reflected in the database.

(*) Append a copy of the records to the table: |Enpigyess |E|

to the source data will not be reflected in the database.

() Link to the data source by creating a linked table.

Access will create a table that will maintain a link to the source data in Excel. Changes made to the source data in Excel will be
reflected in the linked table. However, the source data cannot be changed from within Access,

Eile name: | c:\pocuments and Settings'knelson'\Desktop\Employees. xlsx

If the specified table exists, Access will add the records to the table. If the table does not exist, Access will create it. Changes made

[ Ok l [ Cancel

5. Proceed through the wizard steps as described beginning on page 23.
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